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Manual Overview
The Purpose of this Manual

Thank you for purchasing a WEG SSW900 series full featured soft starter and SSW900-CETH-W Ethernet 
communication module from AutomationDirect. This manual describes the process of updating 
the firmware for both devices. The firmware for both the SSW900 soft starter and the Ethernet 
communication module must match for the devices to work properly. The current firmware version for 
both devices is firware version 1.60.

Technical Support
•  By Telephone:  �770-844-4200 

(Mon.-Fri., 9:00 a.m.-6:00 p.m. E.T.)
•  On the Web:  www.automationdirect.com

Our technical support group is glad to work with you in answering your questions. If you cannot 
find the solution to your particular application, or, if for any reason you need additional technical 
assistance, please call technical support at 770-844-4200. We are available weekdays from 9:00 a.m. to 
6:00 p.m. Eastern Time.
We also encourage you to visit our web site where you can find technical and non-technical 
information about our products and our company. Visit us at www.automationdirect.com.

Conventions Used

NOTE:  When you see the “notepad” icon in the left-hand margin, the paragraph to its immediate right will 
be a special note.

WARNING:  When you see the “exclamation mark” icon in the left-hand margin, the paragraph to its immediate right will be a warning.  This 
information could prevent injury, loss of property, or even death (in extreme cases).
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Current Firmware Version
The firmware for both the SSW900 soft starter and the SSW900-CETH-W Ethernet communication 
module must match for the devices to work properly. The current firmware version for both devices is 
firware version 1.60.

Hardware / Software Requirements:
•  WPS Programming Software found at https://www.automationdirect.com/support/

software-downloads

SSW900 Firmware Update
•  USB type A to miniB programming cable such as MOSAIC-CSU.
•  Firmware file “ssw900_package-v1_60-d1-r6218.fw”, included in the zip file with this manual.

SSW900-CETH-W Firmware Update
•  Ethernet cable such as C5E-STPBK-S3.
•  Firmware file, “ssw900_ceth-w-v1_60-d1-r6222.bin”, included in the zip file with this manual.

Initial Steps:
1)	 Make sure there is no power to the control and line side of the Soft Starter.
2)	 Install SSW900-CETH-W. Note which slot the card is installed in. For installation instructions, see 

the SSW900-CETH-W User’s Guide at AutomationDirect.com.
3)	 Do not connect Ethernet or USB cables until instructed. Do not apply line power at any time 

in this process. AutomationDirect recommends that all input and output side power wiring be 
disconnected before proceeding.

4)	 Apply control power.

Soft Starter HMI Navigation
Using the SSW900 series (hereafter Soft Starter) HMI: (Refer to the SSW900 User Manual at 
AutomationDirect.com for HMI navigation.)

Set the Soft Starter to factory defaults:
Set parameter C10.4 = “Yes” to default all parameters. You may be prompted to enter a password. The 
default password is: 5
After the Soft Starter is reset to factory default, it will prompt you to set the configuration. At this time, 
use all default values.

Check Parameters: 
S3.2.1 for Soft Starter firmware version. Make note of the value.
S3.2.2.8 for firmware version, if SSW900-CETH-W is in Slot 1. Make note of the value.
S3.2.2.10 for firmware version if SSW900-CETH-W is in Slot 2. Make note of the value.

Assess the Need for Firmware Update
If the Soft Starter and SSW900-CETH-W card are V1.60 or higher, no updates are needed, and this 
process is complete. Proceed to normal commissioning.
If the SSW900-CETH-W firmware version is lower than V1.60, then this component will need to be 
updated. 
If the Soft Starter firmware version is lower than V1.60, then this component will need to be updated.
If both components need to be updated, start with the Update SSW900-CETH-W Firmware 
instructions.
If only the Soft Starter needs to be updated, skip the Update SSW900-CETH-W Firmware section and 
proceed to Update SSW900 Series Firmware instructions.

NOTE:  �Before starting either/both update procedure(s), make sure that: 
• There is no power on the Line and Output sides of the Soft Starter. 
• SoftPLC is stopped. 
• Faults are cleared.

https://www.automationdirect.com/support/software-downloads
https://www.automationdirect.com/support/software-downloads
https://www.automationdirect.com/pn/MOSAIC-CSU
https://www.automationdirect.com/pn/C5E-STPBK-S3
https://cdn.automationdirect.com/static/manuals/sswsoftstarters/ssw900_ethernet_manual.pdf
https://cdn.automationdirect.com/static/manuals/sswsoftstarters/ssw900_user_manual.pdf
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WEG Programming Suite (WPS) updating process
1)	 Start WEG Programming Suite (hereafter WPS).
2)	 Click the Help menu and select Check for Updates.

3)	 Follow the on-screen instructions to update WPS.
4)	 After updates are completed, restart WPS.

NOTE:  �Some firewall settings typically controlled by a company’s IT department can cause WPS to not find 
any updates. An error message will appear in WPS indicating a problem with Proxy settings. Consult 
your IT department for resolution.

Verify WPS Plugins
1)	 Click the Tools menu and select Plugins.

2)	 In the Plugins dialog, click the Check for Updates button.
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3)	 When the check is complete, deselect all Plugins, EXCEPT any that are for SSW900.
4)	 If there are SSW900 updates, select them and click the Update button.

NOTE:  �You may leave all updates selected if you choose. However, some of the Plugins are large and require 
significant time to download. ADC recommends selecting only SSW900 updates for this firmware 
update procedure.

5)	 After updating, or if no updates were available for SSW900, click the Installed tab in the Plugins 
dialog. A list of all installed Plugins will be displayed. Sort by Name and verify that the three 
shown Plugins for SSW900 are present and that their Active status shows a green check mark. If 
the Active status is grey, click Select next to the Plugins. The click the Activate button. Verify that 
the Active status is now Green.

6)	 After the update process is complete, close and re-open WPS.
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Updating SSW900-CETH-W Firmware
Using the SSW900 HMI

Set Parameter:
C8.5.1 = 0 – Parameters. This sets the IP as a fixed address. You may be prompted to enter a password. 
The default password is: 5.

Check Parameter:
C8.5.2 IP address. Default is 192.168.0.10. Make a note of the IP address if it is different than default.

PC Settings and Communication Verification:
1)	 Connect an Ethernet cable from your PC to either port of the SSW900-CETH-W card. Do not 

connect the USB cable.
2)	 Using your PC’s Network Settings control panel, set your PC’s IP Address to the same domain as 

the SSW900-CETH-W module.

 
3)	 Open the Microsoft WIndows Command Console. Use the “ping” command to verify 

communications between the PC and the SSW900-CETW-W module.
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WPS Communication Configuration:
1)	 Switch over to WPS software. If there are any Configurations open in WPS, select Close All 

Configurations under the File menu.

2)	 From the File menu, select New Configuration to create a new Configuration that will be used for 
updating the SSW900-CETH-W card. Name the configuration as appropriate for your operation. 
For this guide, we are using the same name in Configuration name and Resource name.

  
3)	 Click Next. This will bring up the Communication Configuration screen.
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On the Communication Configuration Screen:
4)	 Change Preset to SSW900-CETH-W.

a)	 Select the Ethernet radio button. 
b)	 Verify IP address matches Parameter C8.5.2.
c)	 Verify TCP Port = 502.
d)	 Set Unit ID to 254. This is a crucial step. The default value of 255 does not allow access for 

firmware updates. 

5)	 Click Test and verify the information in Status. It is essential to verify the Status message contains 
“SSW900-CETH-W”.

6)	 Click Next. This will bring you to the Device selection screen.
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7)	 On the Device selection screen, verify Type and Version match this screen capture.

8)	 Click Identify Device, Verify data in the Message popup.

9)	 Click OK to close the Message dialog , then Next. This will bring you to the Applications page.
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10)	 No changes are needed on this screen. Click Finish.
11)	 Select the Online menu and click Firmware download.
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12)	 Select Upload a file from system directory and click the three dot Browse button.

13)	 Navigate to the location of the firmware package you downloaded when you downloaded this 
manual. Select “ssw900_ceth-w-v1_60-d1-r6222.bin” and click Open.
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14)	 In the Firmware download data window, click Finish.

15)	 Click OK from the Question popup to confirm the download.

16)	 Follow the firmware update progress in the Status Block of WPS.

•  The component update will be complete when the Satus Block message reads “Firmware 
download successful”.
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Depending on the Slot you installed the SSW900-CETH-W in, you may get a F088 or F089 Slot 
x Fault Connection. This is due to the firmware update and can be reset before power cycle by 
pressing the Back button on the HMI.

   
17)	 Cycle power to the Soft Starter and remove the Ethernet cable from the SSW900-CETH-W 

module.
If you only need to update the SSW900-CETH-W, you can jump to Post Update Steps found later 
in this manual.
If the Soft Starter firmware needs to be updated, follow the process beginning on the next page.



Firmware Update

Page 1–15

Update SSW900 Series Soft Starter Firmware
Preparation:

Connect your PC to the HMI on the Soft Starter with a USB Type A to MiniB cable such as MOSAIC-CSU. 
The USB cable will provide power to the HMI itself, but not the Soft Starter.
If the Ethernet cable for the SSW900-CETH-W update is still plugged into the module, unplug the cable.
Make sure control power is applied to the Soft Starter and there is no line power applied.

1)	 In WPS, select Close All Configurations from the File menu.

2)	 Select File, New Configuration to create a new configuration that will be used for updating the Soft 
Starter.

https://www.automationdirect.com/pn/MOSAIC-CSU
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Name the configuration as appropriate for your operation. We are using the same name in 
Configuration name and Resource name.

3)	 Click Next.
4)	 Select the USB radio button for the Physical layer connection between the PC and Soft Starter.

5)	 Click Test to verify the Status of the USB connection. It is essential to verify that the Status 
message contains “SSW900”.
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6)	 Click Next. The Device selection screen will appear.

Device Selection
On the Device Selection screen, Verify that Type is SSW900 and that the Version is lower than 1.6X.

7)	 Click the Identify Device button. If the Version is 1.60 or higher, the Soft Starter has already been 
updated. If the Version is lower than 1.60, please proceed.
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8)	 Click the OK button to close the Message dialog and click Next to open the Application screen.

9)	 No changes are needed on this screen. Click Finish.
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Verify the new configuration is shown in the Configurations tab in WPS.

10)	 Select Online from the WPS pulldown menu, then Firmware download.
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11)	 Navigate to the location of the firmware package you downloaded when you downloaded this 
manual. Select “ssw900_package-v1_60-d1-r6218.fw” and click Open.

12)	 In the Firmware download data window, Click Finish.

13)	 Click OK from the Question popup to confirm the download.
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Follow the firmware update progress in the Status Block of WPS.

While the updates are downloading, the HMI will indicate “Wait: Do not turn off Control Supply”.

When the message in the WPS Status block reads “Firmware download successful”, this 
component update is finished.

The HMI will read “You must reboot system”.

14)	 Remove the USB cable and reboot the Soft Starter by cycling the control power.
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Post Update Steps
In WPS, close the Soft Starter Configuration file. Then open the SSW900-CETH-W Configuration file. 
Connect an Ethernet cable to SSW900-CETH-W.

1)	 Open the SSW900-CETH-W configuration.
2)	 Select Online from the WPS pulldown menu, then Connect Device.

WPS will generate an Error message requesting a change in resource. Select Yes.

This will bring up the Communication Configuration screen.
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On the Communication Configuration Screen:
3)	 Select the Ethernet radio button. 

a)	 Verify TCP Port = 502.
b)	 Set Unit ID to 255. This is a crucial step. A setting of 254 is used only for firmware updates.

4)	 Click the Test button and verify that the Status message is correct. It is important that the Status 
device is “SSW900” and not “SSW900-CETH-W”. If the device shown is “SSW900-CETH-W”, then 
close this dialog, reboot the SSW900 and restart the Post Update procedure. If the problem 
persists, contact ADC tech support.

5)	 Clicking OK will bring you to the Application window.

6)	 No changes are needed on this screen. Click Finish.
7)	 Close this Configuration. You will not need to use these firmware update configurations again.
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SSW900 Commissioning
1)	 Create a new Configuration for Soft Starter and SSW900-CETH-W parametrization. Name 

as appropriate as this is the Configuration you will use to commission the Soft Starter. For 
demonstration, the same name is used in Configuration name and Resource name.

2)	 Click Next. This will bring you to the Communication configuration screen. The Physical layer 
selection will be USB by default. You can continue your configuration via USB, or change to  
Ethernet. In order to set an IP address other than the default, you must use USB communication.

Using a USB Connection
•  For a USB connection, click the Test button and verify that the Status message is correct. If the 

SSW900 or Device Online is not present in the Status box, verify the USB cable is connected 
correctly, the SSW900 has control power and that SSW900 is selected in the Preset drop 
down.  If the problem persists, contact ADC tech support. Clicking Next will bring up the 
Device selection window. Proceed to Step 3.
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Using an Ethernet Connection
•  For an Ethernet connection, select the Ethernet radio button and verify that the Status 

message is correct. If the device shown is “SSW900-CETH-W”, then close this dialog, reboot 
the SSW900 and restart the Post Update procedure. If the problem persists, contact ADC 
tech support. The Unit ID must be set to 255. Clicking Next will bring up the Device selection 
window. Proceed to Step 3.

3)	 These steps apply to both USB and Ethernet connections. On the Device selection screen, click 
the Identify Device button and verify that the Version reads 1.6X or above and that the Ethernet 
communication module SSW900-CETH-W is shown in the correct slot. Contact AutomationDirect 
technical support if any of the values on this screen are incorrect.
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4)	 Clicking Next will bring up the Application window.

5)	 No changes are needed on this screen. Click Finish.
6)	 Select Online from the WPS pulldown menu, then Connect Device.
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A successful connection is indicated by a green indicator in the bottom right corner of WPS.
Ethernet Connection

USB Connection

7)	 Select Online from the WPS pulldown menu, then Read Parameters From Device.
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8)	 Expand the Parameter window to show additional parameter rows and value columns. Note the 
Online column updating as well as the progress in the Output window at the bottom of WPS.
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9)	 After the parameter upload is complete, check parameter S3.2 Software Version to make sure 
both the Soft Starter and the SSW900-CETH-W module are firmware version 1.60.
The Soft Starter is S3.2.2.1 and the comm card is S3.2.2.8 or .10. depending on the slot it is in.

Firmware update for the SSW900 soft starter and the SSW900-CETH-W Ethernet module is now 
complete. Both are ready for normal commissioning.

User Guide Links
Refer to the WEG User Guides for device and programming specifics.

SSW900 User Manual
SSW900 Ethernet Manual
SSW900 Programming Manual

https://cdn.automationdirect.com/static/manuals/sswsoftstarters/ssw900_user_manual.pdf
https://cdn.automationdirect.com/static/manuals/sswsoftstarters/ssw900_ethernet_manual.pdf
https://cdn.automationdirect.com/static/manuals/sswsoftstarters/ssw900_programming_manual.pdf
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